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第1章 警告和注意事项 
 

本章节包含在安装使用联想 SureFibre220 磁盘阵列之前以及在安装使用过程中需

要注意的一些事项。请仔细阅读并严格遵守本手册中的所有警告标识和注意事项。如果

存在任何疑问，请与联想的技术咨询部门联系。 

1.1 警告 

本手册仅供有安装、配置磁盘阵列经验的专业技术人员使用，联想公司
假定您已经具有安装和维护存储设备的资格，并已受过培训能够识别不同的
产品危险等级。 

避免受伤 

为了避免操作人员在磁盘阵列运输时受伤，请使用机械助力装置来将磁盘阵列运输

并放置到拆装位置。存储子系统的最小配置重量为 37.4 千克，最大配置重量为 51.4

千克。不要抓住机箱后部电源等模块或前部机箱面板来移动磁盘阵列。请使用手推车或

其它机械助力装置来将磁盘阵列从一个位置移动到另一个位置。 

系统供电 

系统电源接通/断开：磁盘阵列后部电源上的开关按钮并不能完全断开磁盘阵列系

统内部的交流电源。即使已经关闭开关按钮，磁盘阵列内部的一些电路可能仍在继续工

作。所以在执行硬件安装操作之前，必须将电源线从交流电源插座拔下，否则，有可能

会引起人员受伤或设备损坏。 

电源的危险状况：电源内始终存在危险的电压、电流。在电源中没有任何用户可维

修的零件；维修必须由专业的技术人员来进行。 

设备和电缆的危险状况：电源线和通信电缆可能存在危险的电气信号。在更换机箱

内任何部件之前，按动后部所有电源上的开关按钮关闭磁盘阵列，并拔掉交流电源线。

否则可能会造成人员受伤或设备损坏。 

1.2 注意事项 

静电保护 

本手册中所有操作必须在静电放电（ESD）工作台上执行，因为磁盘阵列的部件对

静电非常敏感。如果没有所要求的工作环境，可通过下列方法减小静电放电（ESD）的

危害： 

Ø 戴上防静电腕，并将它与磁盘阵列的机箱或其它金属外壳连接 
Ø 在接触磁盘阵列部件前，先触摸一下磁盘阵列的机箱 
Ø 在拿走一些部件之前，使身体与磁盘阵列金属机箱保持接触，放完静电 
Ø 避免不必要的来回走动 
Ø 在拿存储子系统的部件时，仅拿住部件（特别是板卡）的边缘 
Ø 将磁盘阵列的部件放在接地的、防静电的平台上。最好有导电薄膜垫（但不是
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部件的包装材料） 

Ø 不要将部件在任何操作平台上滑动 

散热和通风 

为了保证适当的散热和通风，在接通系统前，必须保证阵列机箱的前部、后部留有

一定的通风空间。否则，有可能会引起系统过热和部件损坏。 

1.3 安全规范要求 

使用范围： 
本产品是在计算机机房或相似环境的计算机操作平台下评测完成的。在其它条件下

使用需要进一步评定。 

对于本节列出的安全使用注意事项，必须仔细理解并在磁盘阵列使用过程中严格执

行，这将有助于您更好地使用和维护磁盘阵列。 

1． 仔细阅读随机光盘提供的资料，全面了解磁盘阵列的使用方法和注意事项。 

2． 检查磁盘阵列的实际配置与装箱单是否一致，如有异议马上与经销商联系。 

3． 您使用的联想 SureFibre220 磁盘阵列采用交流 220V 电源为系统供电。 

4． 一定要使用带接地保护的三芯电源插头和插座，良好的接地是磁盘阵列正常工作

的重要保证；如果缺少了接地保护，在机箱上可能出现 220V 的电压。虽然不会对

人体造成伤害，但是在接触时，可能会产生麻、痛等触电感觉。而且如果擅自更换

标准（通过安全认证）电源线，可能会带来严重后果。 

5． 严格按照本手册中的连线方法安装您的存储子系统，各接插件有锁定螺丝时要注

意拧紧。 

6． 磁盘阵列内部采用了超大规模集成工艺, 温度过高会使系统工作异常,因此使用

过程中一定要注意散热,尤其要注意下面几点： 

s 不要将系统放在靠近热源的地方 
s 不要让阳光直射您的磁盘阵列 
s 在使用过程中千万不要用其他物体堵塞系统机箱的散热孔 

7． 磁盘阵列的某些部件对磁场比较敏感，强磁场对这些部件有很强的破坏作用，因

而要注意防磁，不要将磁盘阵列和磁盘放在靠近磁体的地方。 

8． 过分潮湿的环境也会对磁盘阵列造成不良影响，因而特别要注意防潮，切勿将水或

其他液体泼洒到系统上，一旦不小心发生这种情况，应立即切断系统的电源。 

9． 灰尘对磁盘阵列也有不利的影响，长时间工作在灰尘密度大的环境会使系统内的

部件过早老化、出现故障。 

10． 磁盘阵列中许多部件属于精密仪器，因此移动系统时要轻拿轻放，特别注意不要

在加电状态时搬动，这种操作极易损坏磁盘中的磁头和磁片。即使在断电以后也不

要马上搬运存储子系统，应等待至少 1 分钟，等磁盘完全停止工作后再移动。 

11． 为减少对磁盘阵列的冲击，延长存储子系统寿命，尽量避免频繁重复加电。断电

后，应至少等待 30 秒钟才能再次加电。 

12． 为了避免市电电压的波动或发生突然掉电，造成文件丢失，磁盘损坏，或其他存

储子系统故障，强烈建议您给磁盘阵列配置 UPS。在用 UPS 供电时，应保证 UPS 启

动至少 1 分钟后再接通磁盘阵列电源，以避免 UPS 在刚启动时对系统造成冲击。 
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提醒： 

Ø 当您对 SureFibre220磁盘阵列配置完成后，请及时保存磁盘阵列的配置信息，
以便在发生配置信息丢失时能够及时恢复； 

Ø 在您对 SureFibre220磁盘阵列配置进行修改前，首先将磁盘阵列中的数据进行
备份； 

Ø 当您对 SureFibre220磁盘阵列配置进行修改时，一定确保修改的正确性，并及
时将修改后的配置进行保存； 

 警告： 

Ø 修改或配置 SureFibre220磁盘阵列，有可能导致原来磁盘阵列上保存的数据破
坏或丢失； 

Ø 因用户自己的不正常操作导致数据破坏或丢失，联想将不承担任何责任； 

 注意： 

Ø 请不要轻易修改 SureFibre220磁盘阵列的配置信息，如欲进行此类操作请向相
关的技术专家咨询； 

Ø 确保理解配置信息的含义并在专家的协助下对 SureFibre220 磁盘阵列的配置
信息进行修改； 
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第2章 存储设备开箱检验 
 

本章主要描述在安装联想 SureFibre220 磁盘阵列之前，如何开箱检验及相关的注

意事项。 

2.1 检验磁盘阵列 

将联想 SureFibre220 磁盘阵列从包装箱中取出并检查配件是否齐全。检查包装箱

上有无运输中因野蛮装卸造成的痕迹。若包装箱受损，请仔细检查联想 SureFibre220

磁盘阵列各组件及其配件是否受损。若受损，请立即向您的经销商提出赔偿或更换要求。 

磁盘阵列的包装箱中包含了存储子系统、产品使用的相关资料、运行系统所须软件

以及安装系统所需的配件(如电源线，机柜导轨等)，根据下面的内容核对到货是否齐全： 

Ø SureFibre220R1磁盘阵列一台，单个控制器或SureFibre220R2磁盘阵列一台，
双控制器，均含 14 个硬盘槽位面板，冗余的电源和风扇； 

Ø 随机光盘“联想 SureFibre 磁盘阵列管理软件 SANtricity”V8.XX，软件的版
本分为 8.33 和 8.40，分别对应控制器 Firmware5.33和 5.40，实际版本根据

您的订购而定，光盘中含有电子版的中英文手册； 

Ø 2 个 SFP(SureFibre220R1)或 4 个 SFP(SureFibre220R2)，均插在控制器上； 
Ø 2 根电源线； 
Ø 1 对导轨，用于机柜安装； 
Ø 联想 SureFibre220 磁盘阵列用户手册； 
如有任何物件遗失或损坏，请立即与您的经销商联系。当取出磁盘阵列和包装箱内

物品后，妥善保存包装箱与包装材料，以便在您再次装运时包装存储子系统时使用。 

2.2 检验SureFibre220磁盘套件 

根据您定购的用于 SureFibre220 磁盘阵列的磁盘套件数目检验与实际到货是否一

致，我们提供的磁盘套件分别采用单独的包装，每一块磁盘套件均带有相应的黑色支架

以及保修证书等，出厂时硬盘已经安装在支架上。 

2.3 检验电源线 

如果提供的交流电源线与所需要的类型不完全相符，请勿试图改装或使用它。电源

线是到交流电源的主要通路设备，电源插座应安装在靠近设备的地方并预先接通。如果

由系统提供的电源线与您所在区域的交流电插座不兼容，则您自己采用的电源线应满足

以下标准： 

s 电源线额定值必须与现有的交流电电压相符，额定值至少为存储子系统额定值的
125%。 

s 电源线插头必须是为您所在地区使用所设计的接地型阳插头。它必须具有认证标
志，具有您所在地区相关机构颁发的证明。 

s 插入存储子系统电源上交流电插孔的连接器必须是符合国标标准的阴连接器。 
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第3章 磁盘阵列安装 
 

本章节主要描述安装联想 SureFibre220R 磁盘阵列存储系统的准备事项，以及机柜安装

和磁盘阵列各模块的安装方法和步骤，请确认您是准备开始一个新的系统的安装而不是产品

升级。  

3.1 SureFibre220介绍 

    联想SureFibre220存储系统的硬件可以是SureFibre220R1或SureFibre220R2，均属控制模
组CM（Controller Module），只连接前端服务器主机或交换机设备，不支持JBOD级联扩展。 

SureFibre220R控制模组（Command Module）满配14块硬盘，下面的图示从前后两个视
角向您详细指明这些组成部分。更为详细的说明请进一步查阅相关文档。 

 
图3-1 联想SureFibre220R磁盘阵列前视图 

 
图3-2 联想SureFibre220R1磁盘阵列后视图 

 
图3-3 联想SureFibre220R2磁盘阵列后视图 
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3.2 环境要求 

下面部分内容将向您提供SureFibre220存储系统硬件安装所需要的具体的环境要求。 

首先，系统所将要安置的场所的地板必须能支撑整个SureFibre220R存储系统的重量（包

括机柜以及您未来的扩展计划）； 

其次，必须有足够的活动空间以供实际安装操作者进行安装活动之用。然后还要满足其

他的温湿度、电源等各种物理要求，这样才能保障您的系统能够正常安装和运行。 

3.2.1 空间要求 

    具体空间取决于当前和将来系统的配置情况，但首先必须满足这三个条件： 
Ø 能足够稳定地支撑起您的系统的总重量 
Ø 足够能容纳机柜并安装各个模块的几何空间 
Ø 足够好的可以提供畅通无阻的气流（从前到后）的空间(如图：前面距离>76cm，
后面距离>61cm，总的前后距离应该在230cm以上方可) 

 
      图3-4 机柜放置空间范围要求示意图 

3.2.2 温湿度要求 

    对于温湿度的要求，您需要先了解各模块的气流走向，因为温度的限制和气流的设计
有很大的关系。至少您需要保持系统安装运行前和运行中整个能正常工作时气流畅通。 

3.2.3 电源要求 

    存储系统对电源的要求是比较严格的，系统的供电一定要符合相关的标准，包括电压、
电流负荷、频率、接口类型等，否则会出现严重的后果，很容易损坏系统部件，甚至危及系

统操作者。所以请用户务必注意相关标准。 
任何存储系统的设备电源必须符合厂商的特定要求，SureFibre220R磁盘阵列的电源为
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400W交流电，正常工作的电压范围为100－240VAC，频率范围为50－60Hz，正常工作电流
为1.65A，最大负载流为3.9A。需要进一步指出的是，整个系统的（包括机柜、控制模组）
的电源要求必须同时满足他们三者的共同要求，这样才能保证您的存储系统的正常运行和维

护。 

3.3 工具准备 

要成功地安装和配置您的存储系统硬件，还必须具备一定类型和数量的辅助设备和安

装工具，以及用于连接的线缆等。这一节的内容简要列举了一些会用到的或应该具备的器材，

请您在安装前认真阅读并进行准备。 
ü Hub/交换机、主机适配卡 
ü 19英尺宽的机架柜 
ü 十字螺丝刀和剪刀等 
ü 防静电手套 

3.4 确认准备工作 

当您阅读完本章节的内容并准备好所需的工具之后，您还需要履行以下任务以保证您

的安装准备工作已经按要求完成。这里再提醒一遍：注意手册初始部分的安全警告和注意事

项，同样是不可忽略的。请对照下面的项目逐一进行检查： 
ü 准备好相应的工具和器材 
ü 检查相应的硬件需求和系统信息 
ü 检查现有的网络和硬件配置 
ü 准备好所需的其他网络存储设备（服务器、交换机、适配卡等） 
ü 确认您将要安装的存储系统符合空间、电源要求 
ü 将安装所用的模块、导轨等随机硬件从包装箱中小心取出来并移至安装区域； 

3.5 取出模块 

取出SureFibre220R中的所有模块以减轻模组CM的重量而便于安装，同时通过重新拔插
每个模块组件也可以避免由于运输振荡而造成个别模块组件接触不良。在您安装之前请遵照

以下的步骤逐个取下风扇、电源以及控制器模块。 

3.5.1 取出风扇 

1) 用右手往里推动风扇右下角（左风扇）或左上角（右风扇）的塑料栅，使其
脱卡 

2) 然后用另一只手拉住塑料栅旁边的拉扣，两手一起将风扇拉出槽位 
3) 将风扇轻放在一边 
4) 用同样的方法取出另一个风扇模块 
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图3-5 取出SureFibre220R风扇模块 

3.5.2 取出电源模块 

1) 关掉电源的开关 
2) 用食指勾住锁杆外端的拉环，用拇指轻轻扳动边上的小闩使其脱卡 
3) 然后用力拉动锁杆，将电源模块拉出槽位 
4) 将电源模块放在一边 
5) 用同样的方法取出另一个电源模块 

 
图3-6 取出SureFibre220R电源模块 

3.5.3 取出控制器模块 

1) 往下拨动中间的卡塞Latch； 
2) 双手食指勾住模块的两个拉环，用一个拇指轻轻的按下拉环中间的锁片，使得
拉环弹起 

3) 将拉环分别向左右两边拉至与模块垂直的位置 
4) 双手拉动拉杆，将接口卡模块取出槽位并放置在一边 
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5) 用同样方法取出另外的控制器模块（SureFibre220R1则不需要） 

 
图3-7 取出控制器模块 

3.6 装入机柜 

�警告： 
ü 安装前检查机柜上是否已经安装了电源分配单元 PDU； 
ü 当将磁盘阵列安装到机柜或从机柜卸下磁盘阵列时，一定要检查机柜在稳定性和
牢固性方面是否采取了有效的措施，以确保在进行拆装操作时机柜不会倾倒； 

ü 不要尝试一个人搬动磁盘阵列，请两个人一起搬动磁盘阵列； 
ü 不要使用风扇或电源模块的把手搬动磁盘阵列； 

△!注意： 

ü 安装到机柜的磁盘阵列需要每分钟约 1.1 立方米的通风气流。当在多个机柜上
安放大量磁盘阵列时，需要保证每个磁盘阵列都能得到良好的冷却和通风； 

ü 气流是从机柜前面进从后面排出。为防止从一台磁盘阵列排出的气流紧接着进
入另一台磁盘阵列，机柜应排列成行；而每行的机柜则应是前后交错；机柜两

行之间应保持约 1.2 米的间距； 

ü 为保证机柜间有正确的气流流动，机柜上未安装设备的空间必须安装盲板，机
柜及磁盘阵列间的间隙需要被封闭； 

ü 建议系统运行时的环境温度低于 25℃； 
1. 找到与磁盘阵列配套的机柜导轨（在磁盘阵列包装箱附件盒中）； 

2. 保证磁盘阵列的 3U 高度空间，根据具体情况确定每个磁盘阵列在机柜上的安装位

置；同时保证磁盘阵列之间有 1U 的间隔以便于通风和散热； 

3. 将导轨拉长至机柜深度，先行固定导轨前后部的螺钉，然后拧紧导轨中部的螺钉； 

4. 确认卸下磁盘阵列的主要模块，开始将其安装到机架上： 
1) 取下前面板框上的括扳 
2) 用杆锥卸下模块的前面板架 
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图3-8 拆卸SureFibre220前面板部件 

    警告： 
        为使机柜稳固，请您务必先把磁盘阵列安装在机柜的底部，然后在逐个往上安装，
否则机柜会很有可能发生晃动甚至倾倒，特别是在安装过程中，同样的道理，在拆卸的

时候顺序应该反过来。我们建议在机柜中同时安装服务器、交换机和磁盘阵列等设备时

服务器应在上面，交换机在中间，存储子系统在最下面； 

 
3) 站在机柜的前面，在另一个人的协助下将磁盘阵列的后部放在机柜导轨上，并将
磁盘阵列沿导轨滑入机柜平稳的推入并到位 

4) 用螺钉固定模块：对准模块和机架导轨架前后左右的螺孔，安装螺钉并拧紧；  

5) 按照相反的顺序重新装上前面板架和前面板 

 
图3-9 固定SureFibre220R安装导轨和阵列柜 

3.7 放回模块 

3.7.1 安装风扇模块 

1. 戴上静电防保护； 

2. 确定风扇被正确的放置(左边的风扇弹簧锁靠下, 右边的风扇弹簧锁靠上)； 

3. 滑动风扇外壳进槽之内； 

4. 缓慢推动，直到弹簧锁被卡住； 
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图 3-10   安装风扇模块 

3.7.2 安装电源模块 

1. 戴上静电防保护； 

2. 确定电源开关被关掉； 

3. 把电源插入电源槽 ( 注意控制杠应该朝向中间)； 

4. 推动控制杠到合适的地方并且锁紧它； 

 

图 3-11 安装电源模块 

3.7.3 安装控制器模块 

1. 戴上静电防保护； 

2. 把控制器推进空的槽里； 

3. 关闭两个闸柄，将控制器推入槽内至弹簧锁锁住； 
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图 3-12 安装控制器模块 

3.8 安装磁盘套件 

将磁盘阵列安装到机架上后，可以开始安装磁盘模块，请确保在磁盘阵列的 14 个槽位

中都安装有磁盘槽位面板。 

△!注意： 

ü 磁盘套件很易损坏，请轻拿轻放，并远离强磁场； 
ü 磁盘阵列中任何没有安装磁盘的槽位必须安装磁盘槽位面板。磁盘槽位前面板保证
磁盘阵列中其它安装了磁盘驱动器的槽位周围有正常冷却气流。空置槽位会使磁盘

阵列不能良好散热，并导致磁盘阵列内的一些部件损坏。 

1. 根据您的实际情况，将要安装硬盘套件的槽位面板从阵列中取出，如图： 

 

 

图 3-13 打开磁盘模块的手柄 

2. 按下手柄下端的弹簧锁，拉起手柄，即可将硬盘槽位面板从磁盘阵列槽位中拉出； 
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图 3-14 取出硬盘面板 

3. 紧握手柄，小心地将槽位面板从磁盘阵列中完全拉出。在此过程中，应使用另一只

手托住磁盘模块的底部，防止其掉落； 

4. 重复以上步骤，将足够的硬盘槽位面板都从磁盘阵列中取出； 

5. 逐个从磁盘套件包装盒中取出磁盘套件，打开支架的手柄； 

6. 用一只手托住磁盘支架的底部，另一只手握住手柄，将磁盘支架插入到磁盘阵列相

应槽位中。当磁盘支架前端手柄接触到磁盘阵列前端时停下来。 

△!注意：此时磁盘支架还没有完全插好 

7. 逐渐合上手柄，直到听到手柄发出一声轻响，这样磁盘的光纤接口才可以与磁盘

阵列背板接口吻合连接； 

8. 重复 5-7 步骤，插入其它磁盘套件；  

9. 检查阵列中所有硬盘槽位面板和磁盘套件是否全部对齐，如果没有对齐请拔出后

重新插入。 

 

    至此，您已经可以将存储子系统所有的设备及其组件安装完毕，请继续参照下一章节的

内容连接您的存储系统。 
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第4章 磁盘阵列连接 
 
本章节介绍如何连接磁盘阵列各接口相关光纤线缆及电源线缆的连接，并介绍相关标识
的含义。 

4.1 连接前端设备 

        本章节将简要介绍磁盘阵列存储子系统与前端设备：服务器、交换机、HUB 等之
间的连接。连接之前请先行准备足够的 SFP和 LC-LC的光纤线缆，一般情况下主机服
务器的 FC HBA适配卡已经固定有 SFF，不需要再插入 SFP，而交换机和 HUB的各端
口均需要插入 SFP，才能进行光纤线缆连接，根据您的系统方案设计，有不同的连接方
式，下后面会介绍几中常用的拓朴。 

        如下图所示，联想 SureFibre220R2 磁盘阵列出厂含两个控制器，每个控制器左侧
均有两个连接主机服务器的 Host接口（如下图所示），所以系统最大可以直联四台服务
器；SAN 网络设计则会有更大的灵活性，这里就不再赘述。 

       
图 4-1 SureFibre220R2主机接口示意图 

为便于用户理解和设计存储系统方案，我们以 SureFibre220R2 为例，举四个简单
的方案连接，供您参考： 
①  方案一：单主机双控直联，非冗余，具有故障切换功能 
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图 4-2 SureFibre220R主机连接示意图 1 

       △!说明：您也可以将两条路径全部连接在 SureFibre220R1 的单个控制器上！ 

②  方案二：双主机双控直联，非冗余，无故障切换功能 

 
图 4-3 SureFibre220R主机连接示意图 2 

△!说明： 

您也可以将两条路径全部连接在 SureFibre220R1 的单个控制器上，即可实现典型

的双机方案！ 

③  方案三：双主机双控直联，全冗余，具有故障切换功能 

 

图 4-4 SureFibre220R主机连接示意图 3 
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④  方案四：双主机双控 SAN 网络连接，冗余，具有故障切换功能 

    
图 4-5 SureFibre220R主机连接示意图 4   

 △!注意： 

ü 联想 SureFibre220磁盘阵列支持的 FC HBA适配卡主要有三个厂商： 
Qlogic Qla2310F/Qla2340L/Qla2342L等，支持 WinNT/XP/NetWare/Linux/Solaris；  
Emulex LP9002L/9802/982等，支持WinNT/XP/NetWare/Linux/Solaris/HPUX/AIX； 
LSIlogic  FC40919O/FC44929O 等,支持 WinNT/XP/NetWare/Linux/Solaris/SCO；  
服务器 HBA 适配卡必须独占一个 64 位的 PCI 段，机架式服务器中 HBA 应该插在靠

近主板的 PCI 槽位中； 

其中由于 Qlogic 的 Qla2310F出厂默认设置中速率是 1Gb/s，请在使用之前务必将
其速率改为 1G/2G自适应！方法：在系统 POST 自检时根据提示按键 Alt+Q或 Ctrl＋Q
（依 BIOS版本而定），进入 HBABIOS配置菜单，选择 Advanced Configuration/Extended 
Firmware Setting/Data Rate/0→2；其它 HBA也一样须将速率设为 2Gb/s 或 1/2G 自适应！ 
ü 如果连接磁盘阵列后操作系统不能启动，如显示 OS Not Found，则同样进入 BIOS， 
选择 Host Adapter Setting/Host Adapter BIOS/ Enable→Disable，一般如果不在磁盘 
阵列上安装操作系统，FC HBA的 BIOS必须关闭！ 

ü 联想 SureFibre220磁盘阵列与 JNI 和 LSI的 HBA卡混合联在同一 SAN 存储区域 
网络中会有冲突，JNI HBA会把 LSI的 HBA视为 Target，同时与 Qlogic 和 JNI 
的 HBA卡混合联在同一 SAN 存储区域网络也会有冲突，Qlogic 的 HBA会把 
JNI HBA视为 Target； 

ü 各 HBA在 Linux和 Solaris 等操作系统下默认驱动的配置文件（或操作系统本身） 
只支持一个 LUN，这与阵列无关，解决办法请参考 HBA相关设置手册； 

ü 联想 SureFibre220磁盘阵列前端连接 Brocade交换机时，与阵列相连的交换机端口
必须保证是 F_Port，如果为 FL_Port则可能会导致控制器离线； 

4.2 磁盘阵列加电检验 

�危险 
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仅当磁盘阵列连接安装完毕，并且机柜固定螺丝被拧紧后，才可以将电源线插入磁

盘阵列的电源插孔中。 

i提醒 
请使用磁盘阵列自带的电源线。 

4.2.1 连接线缆加电 

1. 在磁盘阵列的背后，将电源线插入每个电源模块的电源接口中； 

  

图4-6 连接电源线缆 

 

2. 将电源线的另一端插入机柜电源插座中（请参考机柜的安装和服务指导手册），如
果电源有开关，需要保证开关是开的。 

△!  警告： 

存储系统的启动顺序请严格按照下面步骤进行，否则会造成数据丢失等严重后果！ 

→Switch（交换机启动保证至少 15分钟） 
→RAID（启动 SureFibre220R） 
→Server服务器 
系统关闭顺序与此相反，必须保证服务器已经完全关闭再行关闭存储子系统，

系统重新启动之间的间隔保证在5分钟，以使得存储系统完全关闭，各组件和部件
停止工作； 

3. 将每个电源DC ON/STANDBY开关①设置为ON，则绿色的Power电源指示灯变亮。如果
电源故障指示灯点亮，就说明SureFibre220磁盘阵列供电或电源模块存在故障； 

4. 系统启动后，先行检查存储系统前端服务器和交换机指示灯： 
ü HBA：Qlogic 的 HBA 指示灯状态为绿灯常亮，橙色灯灭，Emulex 也是绿灯 
常亮，但是橙色灯闪亮（1Hz 闪表示 1Gb/s，4Hz 闪表示 2Gb/s） 

ü 交换机：电源指示灯绿色常亮，各端口上面各有两个指示灯，左边绿色常亮表 
示端口链路处于连通状态，右边绿色常亮表示速率为2Gb/s；  

4.2.2 检查前部指示灯 

指示灯是指示存储系统在加电工作时的状态。 绿色指示表示正常运行状态；橙色指示
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表示一个可能存在或发生的故障。除了为检查故障之外，你还能从相应的指示灯来判断是否

存在主机对磁盘阵列的IO操作。 

如图，了解磁盘阵列前部各指示灯位置： 

 

图 4-7 SureFibre220前部指示灯 
 

各指示灯具体含义请参照下表： 

 

指示灯 颜色 操作状态 

磁盘活动 绿色 ² 常亮--正常状态 
² 闪烁--数据正在被读或写到磁盘上 
² 关闭--阵列存储电源关闭 

磁盘故障 橙色 ² 关闭--正常状态 
² 闪烁--管理软件正在查找磁盘、卷或磁盘阵列 
² 常亮—磁盘故障 

电源指示 绿色 ² 常亮—正常 
² 关闭—电源供应中断或电源没连通或环境温度过高  

故障指示 橙色 ² 关闭--正常状态 
² 常亮—磁盘阵列故障 

  

加电稳定后 SureFibre220 磁盘阵列以及安装有硬盘的槽位的指示灯状态如下所示 

ü 磁盘活动指示灯：常亮（有磁盘的槽位，如果没有安装磁盘当然是灭的） 
ü 磁盘故障指示灯：关闭 
ü 电源指示灯：常亮 
ü 故障指示灯：关闭 
如果以上所示的指示灯是正确的，同时没有报警声音出现（此时故障指示灯会亮橙

色），则说明磁盘阵列系统中的各单元模块安装成功。如果系统有报警，请摁下消音按

钮将报警声音关闭，检查阵列前后部各指示灯是否有故障指示，如果有请采取相应措施

或与联想存储的技术支持人员联系。如果各部件指示灯显示均没有问题，请直接转至下

一章节的磁盘阵列串口管理，进行系统配置信息的清除。 

△!注意 

ü 如果磁盘驱动器模组中的硬盘是水货、假货，则没有指示灯； 
ü 请使用存储管理软件进行进一步精确的故障识别； 
ü 不是所有的元件故障都会有指示灯显示 
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4.2.3 检查后部指示灯 

联想 SureFibre220R 后端状态指示灯比较多，请参见下面的图表，并根据您的系统

连接情况，检查确认您的存储子系统的工作状态。 

如图，了解 SureFibre220R 磁盘阵列后部各指示灯位置： 

 

图 4-8 SureFibre220R后部指示灯 
 

各指示灯具体含义请参照下表： 

代码 指示灯 颜色 操作状态 

A 风扇故障 橙色 ² 常亮—发生风扇故障 
² 关闭--正常状态 

B 电源状态 绿色 ² 常亮—电源正常加电 
² 关闭—电源未加电 

C 电源故障 橙色 ² 常亮--发生电源故障，或只有单电源供电 
² 关闭--正常状态 

D H0 接口状态 绿色 ² 常亮—主机或交换机连接正常状态 
² 关闭—主机或交换机没有连通 

E H0 速率 绿色 ² 常亮--正常状态 2Gb/s 
² 关闭—主机连接 1Gb/s 

F H1 接口状态 绿色 ² 常亮--主机或交换机连接正常状态 
² 关闭--主机或交换机没有连通 

G H1 速率 绿色 ² 常亮--正常状态 2Gb/s 
² 关闭--主机连接 1Gb/s 

H BBU 状态 绿色 ² 常亮--正常状态，电量充足 
² 闪烁—BBU 正在充电 

I Cache 状态 绿色 ² 常亮—Cache 中有数据尚未刷入磁盘 
² 关闭—Cache 中没有数据写入 

J 控制器故障 橙色 ² 常亮—控制器存在某种故障 
² 关闭--正常状态 

K 阵列速率 绿色 ² 常亮--正常状态 
² 关闭—1Gb/s 

L ID 冲突 橙色 ² 常亮—存在 ID 冲突 
² 关闭--正常状态 
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对照上面的表格，如果四个主机接口都连接有 2Gb/s 的主机或交换机设备，则实际

指示灯应该和表格中的斜线并加粗部分内容一致，如果有问题请联系相关技术支持工程

师。刚开始系统启动的时候 H（BBU）指示灯可能处于快闪状态，说明由于长期系统没

有开机，BBU 会逐渐缓慢耗电，这时就会进行充电，一般用不了多久就可以充电完毕，

即时就会显示正常。其它不同的系统连接配置，您可以依据实际配置和指示灯说明自行

进行识别。 

4.3 磁盘阵列的配置 

联想 SureFibre220 磁盘阵列系统支持主机服务器 FC 路径的带内管理、控制台以太

网路径的带外管理和控制器串口管理三种管理、监控和配置方式，根据您的实际需求选

择您条件允许的或习惯的管理方式。此外，使用串口 (RS-232)的还可以诊断控制器和

设置控制器的 IP 地址。 

1． SAN 带内管理： 

必须有和磁盘阵列直接连接或同处于 SAN 网络同一分区内的主机服务器，目前

Firmware5.33版本只支持Windows 2000 Server/Advanced Server和Solaris Sparc

平台，具体参见下一章的关于 SANtricity8.33 管理软件的介绍； 

2． Ethernet 带外管理： 

采用 RJ45 接口网线分别连接两个控制器的以太网口，连入您的内部局域网络， 

然后使用串口配置控制器的 IP 地址，使得您局域网内的控制台或工作站或 PC 终端

可以使用 SANtricity 管理软件进行管理； 

   如图所示，连接以太网连接线缆，请务必同时连接两根网线！ 

 

图 4-9 SureFibre220R网络和串口接口 
3． RS232 串口方式： 

分别连接控制器的RS232接口，SureFibre220R控制器支持交叉方式的串口线，

这种管理方式一般只用来清除系统配置并更改控制器 IP 地址，系统出厂设置为

192.168.128.101 和 192.168.128.102，您可以根据您的实际需求来进行更改。 

串口超级终端波特率为 9600，数据位 8，停止位 1，无校验，无流控制，进入

连接状态后同时按 Ctrl+Break，此时系统会提示在 5 seconds 内按 ESC 即可进入

Shell，如果按空格 Space 则会将控制器波特率更改为您终端设置的波特率值， 

提示输入用户名：请键入 infiniti，回车； 

一般做三步操作： 

>sysWipe 

擦除阵列所有配置信息，恢复起始出厂设置，如果先前系统加电时有报警

现象发生而各部件又工作正常，这是一个很有效的方法； 
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>netCfgShow 

    察看当前网络设置，主要是 IP 地址、网关和子网掩码； 

>netCfgSet 

    更改控制器 IP 地址； 

        需要说明的是三个步骤都必须在两个控制器上分别进行一次操作，同时控制

器也会重起，IP地址更改后，请检查确认均可以Ping通！ 

△!  警告： 

串口配置使用只允许以上三种操作，其它操作未经联想允许或非经联想技术工

程师操作不允许进行，否则造成的任何后果由用户自己承担！ 
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第5章 安装管理软件SANtricity 
 

        本章节内容主要讲述联想 SureFibre220磁盘阵列的管理软件 SANtricity，包括基本
介绍和带内管理、带外管理两种管理方式的软件安装和运行。 

△!  注意：当前 SureFibre220 只支持 SANtricity8.33 版本！ 

5.1 管理软件介绍 

联想 SureFibre磁盘阵列管理软件 SANtricity Storage Manager 主要用于监控、管理、
维护和配置联想 SureFibre210/220/620/820/920系列磁盘阵列存储子系统。 

SANtricity Storage Manager 软件 V8.33支持如下几种操作系统： 

Ø Linux RedHat 
Ø Solaris 8.0 
Ø Windows 98/NT/2000 

SANtricity Storage Manager 软件提供两种管理方式： 

Ø Host-Agent 带内管理方式 

Ø 以太网带外管理方式 

两种管理方式的架构如下图所示： 

 

图 5-1 SureFibre220管理软件支持的管理方式构架 

² Host-Agent 带内管理方式 

Host-Agent管理方式是通过存储网络或主机服务器直接与磁盘阵列相连，主机
服务器上运行 Agent使得管理软件能够通过主机与存储阵列间的 Fibre Channel I/O
通道与存储阵列的 Access Volume进行通信，实现监控、管理和配置功能。 
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² 以太网带外管理方式 

在以太网带外管理方式中，管理工作站通过以太网直接与每个控制器相连，监

控与管理工作通过以太网而不是 Fibre Channel I/O通道完成。您也可以将服务器主
机作为带外管理工作站。 

 SANtricity组件 

SANtricity Storage Manager 管理软件主要由以下四个组件构成： 

Ø RDAC 

Ø SMutil 

Ø SMagent 

Ø SMclient 

² RDAC 
RDAC 软件包是带内管理时主机端必须安装的部分，即 Redundant Disk Array 

Controller 多路径驱动。RDAC多路径驱动主要提供 I/O路径失效情况下的故障切
换支持。RDAC 软件包必须安装在所有与存储阵列通过 Fibre Channel相连的主机
上。 

² SMutil 
SMutil软件包也是带内管理时主机端必须安装的部分，包含向操作系统注册
和映射新建逻辑卷所需使用的工具。SMutil软件包也必须安装在所有与存储阵列
通过 Fibre Channel相连的主机上。 
² SMagent 

SMagent软件包是主机端可选安装部分，提供 Host-Agent管理方式的支持。
SMagent 负责管理软件与存储阵列的通讯，通讯通过主机与阵列间的 Fibre 
Channel I/O通道完成。SMagent软件包必须安装在需通过 Fibre Channel连接提供
阵列管理路径的所有主机上。此组件在使用带内管理方式时必须安装。 

△!  注意： 

由于 Agent 服务是建立在与磁盘阵列的 Access Volume 虚拟卷进行通讯的基

础上才能运行的，请千万不要删除该卷，否则就不能启动 Agent 服务，也就不能

进行带内管理，而且如果要重新生成 Access Volume 卷唯一的方法就是如串口方

式进行的 sysWipe 命令或通过带外的方式将 Configuration Reset，这样就会将

原有配置信息和数据清除！ 

Access Volume在W2K磁盘驱动中应该显示为 LSI Universal X-Port SCSI Disk 
Device，同时 Agent服务能够启动才能实现 SANtricity带内管理； 

² SMclient 
SMclient软件包是管理工作站端必须安装的部分，主要包括管理存储阵列所
需要的软件工具。SMclient 通过捆绑在一起的 Enterprise Management Window 
(EMW)和 Array Management Window (AMW)来定义、监控和管理存储阵列。事件
监控器是可选服务，在 EMW没有运行的情况下仍能够提供事件的监控与通知。
只需在一台管理工作站上配置事件监控器，以防收到重复的事件通知。通常情况

下，事件监控器应安装在每日 24小时工作的管理工作站上。 
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5.2 管理软件安装和运行 

由于 SANtricity833支持 NT/Windows、Linux和 Solaris 三个操作系统，下面我们依次介
绍三个版本管理软件的具体安装方法和步骤。 

5.2.1 SANtricity For Windows  

 系统要求 

工作站带外管理 
ü 奔腾系列处理器，主频 133MHz或以上； 
ü Win98下内存需求为至少 98MB，Windows NT 与 Windows 2000下为 128MB， 

Windows 2000下建议使用 256MB以上的内存； 
ü 以太网卡、网卡驱动程序和一个连通的局域网络环境； 
ü CDROM光驱； 
ü 鼠标、键盘； 
ü AGP（推荐）或 PCI 视频卡； 
ü 最少 800×600显示分辨率，256色，建议使用 1024×768 显示分辨率，64K颜色； 
ü 安装 TCP/IP协议； 
ü 需要使用的磁盘空间：最少60MB，Windows 2000下需全部磁盘可用空间为100MB； 

主机服务器带内管理 
ü RDAC 需可用磁盘空间 7MB； 
ü Microsoft Virtual Machine需可用磁盘空间 1MB； 
ü SMagent需可用磁盘空间 1MB； 
ü SMclient需可用磁盘空间 60MB； 
ü Windows 2000下需全部磁盘可用空间为 100MB；     
ü Windows 2000 （Advanced ）Server 必须至少打 SP3及其以上版本的补丁； 

 安装步骤 

SANtricity Storage ManagerFor Windows 安装光盘提供了基于 GUI 的工具 CD 
Browser 来帮助完成安装过程： 
1. 将安装 CD放入 CD驱动器内，如果 CD Browser 没有自动启动，则执行 setup.exe，
启动 CD Browser； 

2. 选择 Installation页； 
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图 5-2 安装 SANtricity W2K：选择 Install 

3. 如果只需带外管理方式，选择“Storage management station installation packages”，
安装存储管理工作站所需软件包； 

 
图 5-3 安装 SANtricity W2K：选择 Station方式 

a. 在 Win2000下不需重新安装 Microsoft Virtual Machine； 
b. 在安装 SMclient时，会弹出对话框询问是否安装事件监控器（Event Monitor），
若有多台存储管理工作站，只需在其中一台计算机工作站上安装即可，通常该

台工作站设定为每日 24小时处于工作状态； 

 
图 5-4 安装 SANtricity W2K：安装 Event Monitor 
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c. Windows系列操作系统下，不需安装 Frameworks。 

△!  注意： 

如果上述超级连接失效无法使用，请直接进入光盘安装目录按照相同的顺序安

装相关组件即可！ 

 
4. 如果需要进行带内管理，即安装在服务器主机，需选择“Host installation packages”
选项，按顺序安装所需的软件包组件； 

 
图 5-5 安装 SANtricity W2K：选择 Host方式 

a. 在 Win2000下不需重新安装 Microsoft Virtual Machine； 

b. 安装 RDAC，安装完成后，安装程序会询问是否重启系统，选择 no，在所有
软件安装完毕后再重启系统； 

 
图 5-6 安装 SANtricity W2K：安装完成 RDAC 

c. 安装 SMutil； 
d. 安装 SMagent； 
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e. 安装 SMclient; 

f. Windows系列操作系统下，不需安装 Frameworks。 
5. 选择 Exit 退出 CD Browser，重启系统； 
6. 如果安装了 RDAC，系统会在重启后检测到新硬件，并提示安装驱动程序，可以在
安装光盘的 hostinstall\rdac\目录下找到驱动程序文件 rdacfltr.sys，安装驱动程序并
重新启动操作系统； 

7. 安装完毕。 

 运行软件 

   打开 Windows开始菜单，选择 程序→SANtricity Storage Manager Client即可 

5.2.2 SANtricity For Linux  

 系统要求 

工作站带外管理 
ü OS：Linux RedHat 7.2 Kernel 2.4.7-10，glibc2.4及其以上 
ü 奔腾系列处理器，主频 133MHz或以上，Intel X86平台； 
ü 128MB以上的内存； 
ü 以太网卡、网卡驱动程序和一个连通的局域网络环境； 
ü CDROM光驱； 
ü 鼠标、键盘； 
ü AGP（推荐）或 PCI 视频卡； 
ü 最少 800×600显示分辨率，256色，建议使用 1024×768显示分辨率，64K颜色； 
ü 安装 TCP/IP协议； 
ü 需要使用的磁盘空间：37MB /tmp，85MB /opt； 
主机服务器带内管理 

△!  注意：Linux下不支持 Host-Agent方式的带内管理 

 安装步骤 

1. 作为超级用户登陆； 
2. 将软件安装 CD放入 CDROM，并 Mount：mount /dev/cdrom /mnt/cdrom; 
3. 进入安装目录 cd /mnt/cdrom/clientinstall 依次安装 SMruntime和 SMclient： 

   rpm –ivh smruntime.install.i386.rpm 
rpm –ivh smclient.install.i386.rpm 

4. 或进入安装目录 cd /mnt/cdrom/hostinstall 依次安装SMruntime、SMutil和SMmclient： 

   rpm –ivh smruntime.install.i386.rpm 
   rpm –ivh smutil.install.i386.rpm 

rpm –ivh smclient.install.i386.rpm 

 运行软件 

    进入程序安装目录：/opt/SM8/client，运行管理软件即可：./SMclient 
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5.2.3 SANtricity For Solaris  

 系统要求 

工作站带外管理 
ü OS：Solaris 8.0＋108528-16 patch 
ü Sparc S20处理器以上； 
ü 256MB以上的内存； 
ü 以太网卡、网卡驱动程序和一个连通的局域网络环境； 
ü CDROM光驱； 
ü 鼠标、键盘； 
ü AGP（推荐）或 PCI 视频卡； 
ü 最少 800×600显示分辨率，256色，建议使用 1024×768显示分辨率，64K颜色； 
ü 安装 TCP/IP协议； 
ü 需要使用的磁盘空间：126MB /opt； 
主机服务器带内管理 
ü RDAC 需可用磁盘空间 1MB； 
ü Smruntime需可用磁盘空间 49MB； 
ü SMagent需可用磁盘空间 50MB； 
ü SMclient需可用磁盘空间 57MB； 
ü Solaris 下需全部磁盘可用空间为 157MB； 
ü 其它要求同工作站相同！   

 安装步骤 

1. 以超级用户登陆； 
2. 如果已经安装有 Veritas Volume Manager DMP，先行将它删除； 
3. 安装相应的软件包，如果是工作站带外方式管理，则： 

pkgadd -d /cdrom/sansm833/clientinstall 
根据提示，依次选择安装 SMruntime→SMclient→SMOvclnt；由于安装包有一
定的先后安装顺序，请不要选择 All方式； 

4. 如果是主机服务器带内管理方式，则 

pkgadd -d /cdrom/sansm833/clientinstall 
根据提示，依次选择安装 SMruntime→RDAC→SMmagent→SMutil→SMclient
→SMOvclnt；同样由于安装包有一定的先后安装顺序，请不要选择 All方式； 

5. 重新启动系统：/etc/shutdown -y -i0 -g0；boot -r； 

 运行软件 

进入程序安装目录：/opt/SM8/client，运行管理软件即可：./SMclient 

5.3 管理软件运行界面 

根据上一章节所述的方法安装并运行管理软件，如果是选用工作站直接管理方式，只需

直接启动 SANtricity Storage Manager Client即可，事件监视器 Event Monitor作为系统服务已
经由系统自动启动；如果选用 Host-Agent 主机服务器带内管理方式，还需有必要首先查看
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主机端 Storage Manager Agent是否已经启动，若没有，则手工启动它，然后再启动 SANtricity 
Storage Manager Client。 
初次启动时，如果 SANtricity Storage Manager Client中没有定义任何用户需要管理的磁 
盘阵列或主机，将弹出“Initial Automatic Discovery”对话框，询问用户是否需要系统自动
搜寻磁盘阵列设备和主机设备，如下图所示： 

 
图 5-7 运行 SANtricity：初始界面 

 
您可以选择“Yes”让管理软件自动搜索所连接的 SAN 存储网络或局域网络中的

SureFibre220及其同一系列的存储设备，当然您也可以选择“No”以待手动添加存储设备。 
SANtricity 管理软件有两个主要的窗口：Enterprise Management Window 和 Array 

Management Window；如下图所示： 

 
图 5-8 运行 SANtricity：EMW和 AMW界面 
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5.3.1 Enterprise Management Window 

Enterprise Management Window 是启动 SANtricity客户端软件后最先显示的界面。提
供一个树状管理设备列表（Device Tree），安装 SANticity客户端的主机是这个设备列表
的根节点。设备管理树能够显示安装 Host-Agent主机系统和直接连接在以太网上的存储
设备，是可以实现 SAN 存储网络集中管理的功能。 
如图所示直接挂接在 Storage Management Station下的是通过带外管理方式，而其它
通过 Host***下面用二级树显示的则是通过带内 Host-Agent方式进行管理的，如果您安
装的是带内管理的软件包而且服务器和磁盘阵列有局域网络相连通，那么两种方式显示

都会出现。 

 
图 5-9 运行 SANtricity：EMW界面 

使用 Enterprise Management Window 可以做到： 

² 添加和侦测用户需要管理的磁盘阵列； 
² 提供一个直观的图形化管理界面； 
² 利用 Script Editor 完成对所有管理的磁盘阵列的管理任务； 
² 配置日志事件发送给用户的各种方式（E-mail,SNMP）。 
所有与磁盘阵列配置相关的一些信息都存放在安装 SANTricity 客户端的计算机上，
存放信息的文件名为：emwdata.bin。利用这个配置文件，可以对管理的磁盘阵列进行标
识，便于管理。如果要接收磁盘阵列系统的日志报警信息，Enterprise Management Window
必须一直运行，或者使用 Event Monitor。 
在添加需要管理的磁盘阵列后，可以使用 Enterprise Management Window 可以监控磁
盘阵列的各种状态。如果在 Enterprise Management Window 监控到磁盘阵列处于非不正常
状态，用户可以启动 Array Management Window 了解更详细的信息，同时还可以通过 Array 
Management Window 完成或恢复其它一些管理任务。 
可以使用两种方法在设备树中添加需要管理的设备： 
² 利用自动扫描选项，SANTricity客户端软件能够扫描到同一个子网内的存储设  
备，并且把它添加到管理界面中，界面右下角会显示搜索进程； 

² 使用添加设备选项，通过制定需要管理的存储设备的 IP 地址，将设备添加到管 



联想 SureFibre220磁盘阵列用户手册 

31 

理界面之中，即通过 Edit->Add Device选项手工增加设备，一般带内方式 Device
可以是服务器名称或其 IP 地址，也可以是默认的 LoopBack地址 127.0.0.1，如果
是带外方式可以直接键入控制器的 IP 地址（请事先连接网络并保证两个控制器
的 IP 地址均可以 Ping通）。需要将两个控制器的 IP 地址全部逐一 Add。 

 注意： 
当第一次添加设备的时候，设备显示为“Unamed”，您可以进入 Array Management 

Windows将之重新命名！ 

 

Enterprise Management窗口菜单选项如下表所示： 

Menu 描  述 
Edit 通过 Edit 菜单选项，可以增加和删除需要管理的存储设备；配置系统报
警信息和设备的描述。 

View View 下的一些菜单选项可以按照名称、状态、管理类型，设备描述对管
理的存储设备进行排序。（另外一个选项“Partially Managed Devices”） 

Tools 通过工具选项可以让系统自动侦测子网内的存储设备或是重新扫描新增
加到主机中的存储设备，也可以刷新管理界面，启动 Array Management
窗口去管理选定的存储设备。当然也可以打开脚本配置界面进行系统配

置和重新装载保存好的配置文件。 

Help 软件使用的在线帮助系统 

 

Enterprise Management窗口的工具栏选项如下表所示： 

按钮 描  述 
Automatically detect new devices 

 

自动侦测子网内的存储设备 

Rescan selected host for new devices 

 

重新扫描接入主机系统中的存储设备 

Synchronize Event Monitor 

 

事件监控 

Add host/device 

 

添加存储设备 

Remove host/device 

 

删除存储设备 

Launch an Array Management Window 

 

启动 Array Management 管理窗口 
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5.3.2 Array Management Window 

若要配置和维护设备列表中的设备，需启动 Array Management Window 窗口。对于
每一个独立的存储设备，Array Management 管理窗口都不是完全一样的。在 Array 
Management Window 中有两个标签，显示不同的信息： 

 

 

图 5-10 运行 SANtricity：AMW界面 

标签 描  述 

Logical/Physical View 
包含：Logical View 和 Physical View 
Ø Logical View：显示逻辑设备的情况，磁盘阵列中
卷组和卷的组成情况； 

Ø Physical View：显示磁盘阵列物理设备的情况，如
控制模组，磁盘模组，并且可以浏览这些物理设备

的状态，如温度等。 

Mappings View 包含：Topology View 和 Defined Mappings View 
Ø Topology View ：以树状的结构图形显示逻辑设备
和存储分区之间的关系。 

Ø Defined Mappings View： 显示被选中的逻辑设备与
其它设备的详细映射关系。 

 
使用 Array Management管理窗口，可以配置和维护存储设备中的逻辑和物理的设备； 

Array Management窗口菜单选项如下表所示： 

Menu 描  述 
Storage 
Array 

Storage Array 菜单选项可以实现一下的一些磁盘阵列管理操作： 
Locating indicator lights：定位指示灯 
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Configurating the storage array：配置磁盘阵列 

Enabling premium features：增加附加功能 

Starting Recovery Guru：开始故障恢复向导 

Monitoring performance：监控性能 

Downloading firmware and NVSRAM files：更新固件程序 

Changing various settings：修改一些设置 

Setting controller clocks：设置控制器时钟 

Redistributing volumes：重新分配卷 

Running Read Link Status diagnostics：运行状态检测 

Renaming volume：重新命名卷 

View View 菜单选项可以改变如下视图的显示状况： 
Logical/Physical：切换到 Logical/Physical视图 
Mappings：切换到 Mappings 视图 
Associated Components：显示关联组件 
Find：查找设备 
Find Next：查找下一个 
Go To (Snapshot and Repository)：选择显示某一个卷的视图 
Event Log：显示日志事件 
Storage Array Profile：磁盘阵列设备总览 

Mappings Mappings 菜单选项可以改变或者建立映射信息： 
Define：定义一个映射 
Change：修改一个映射 
Move：移动一个映射 
Replace Host Port：替换映射中主机端口 
Show All Host Port Information：显示所有的主机端口信息 
Delete：删除一个映射 
Rename.：重新命名一个映射 

Volume 
Group 

Volume Group 菜单选项可以实现以下的一些卷组管理和操作功能： 
Creating volumes：创建卷 
Locating：定位卷 

Changing Redundant Array of Independent Disks (RAID) level or 
Controller ownership：改变 RAID级别，或者卷所属的控制器 
Adding free capacity (drives)：增加容量 
Defragmenting free capacity：整理磁盘容量 
Placing controllers online or offline：停止或启动控制器 
Initializing a volume group：初始化卷组 
Reviving a volume group：恢复卷组 
Checking redundancy：冗余校验 
Deleting a volume group：删除卷组 

Volume Volume菜单选项可以实现以下的一些卷管理和操作功能：  
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Creating：创建一个卷 
Changing ：修改卷的属主和条带大小 
Increasing capacity：增加卷的容量 
Initializing：初始化 
Deleting：删除卷 
Renaming ：重新命名卷 
Snapshot：创建或删除 Snapshot卷 
Properties：显示卷的属性 

Controller Controller 菜单选项可以实现以下的一些管理和操作功能： 
Place：停止或启动控制器 
Date transfer (I/O)：停止或启动数据传输 
Change：修改一些参数，Loop ID，Active等 
running diagnostics：运行诊断工具 
properties：浏览控制器的属性 

Drive Drive菜单选项可以实现以下的一些管理和操作功能： 
Locating：定位磁盘  
Hot spare：热交换磁盘的设置 
Failing：错误信息 
Revive：恢复 
Reconstructing：重建 
Initializing ：初始化 
Properties：显示磁盘属性 

Help 显示帮助信息和相关的版本信息 

 
Array Management窗口的工具栏选项如下表所示： 

按钮 描  述 
Create new volumes 

  

创建一个新的卷 

View diagnostic event log 

 

打开日志时间显示界面 

Monitor performance 

 

打开性能监控界面 

Recover from failures 

 

启动故障恢复向导，只有在存储设备处于 Needs 

Attention 状态下显示为 时，此选项才能被选中。 

Find node in tree 

 

查找定义的设备 
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第6章 配置监控磁盘阵列 
 
本章主要介绍如何创建卷与卷组、如何配置卷的映射、如何保存和加载配置信息，最后

简要介绍一下其它附加功能。 
在配置磁盘阵列的时候，首先确定合适的数据保护策略，以及这些存储容量如何被组织

分配使用。这一章将介绍一些基本的卷和卷组的概念和配置方法，对一些更细节的描述，可

以查看相应的帮助文件。 

6.1 配置卷组和卷 
逻辑卷是由用户为了满足数据存储需要在磁盘阵列上创建的一个逻辑的存储结构，通常

建立在多个物理硬盘的基础之上。通常把创建逻辑卷的一系列物理硬盘的组合称为卷组（即

一个RAID组）。一个卷组拥有RAID级别，容量等特性。用户可以从尚未配置的卷组容量中
创建一个新的逻辑卷。 
配置卷组前请先行察看阵列信息：选择菜单“View”→“Storage Array Profile，查看系
统Firmware和NVRAM版本信息：Firmware应该为05.33.××.××，SureFIbre220R2的
NVRAM版本应为N2882-533834-400，SureFIbre220R1的NVRAM版本应为
N2882-533834-401，如有不一致问题，请依次刷新磁盘阵列控制器的Firmware和NVRAM，
选择“Storage Array”→“Download”→“Firmware”和“NVRAM”，从随机管理软件光盘
中找到相应的微码文件，进行刷新即可，提醒刷新的时候请务必停止所有的I/O操作！ 
卷与卷组的创建可以通过Create Volume Wizard完成： 
打开所要配置的存储设备的Array Management窗口，点击菜单项Volume Group->Create 

Volume或Volume->Create进入Create Volume Wizard，如下图所示： 

 

 
图6-1 配置RAID卷：选择操作系统 
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1. 在下拉列表中选择主机操作系统类型，点击 OK； 

 

图6-2 配置RAID卷：磁盘空间选择方式 
 

2. 选择新建卷的位置，可以使用已有卷组的剩余空间，也可以使用还没有配置的存储
空间，点击 Next； 

3. 如果选择使用未配置空间，则进入卷组的创建，如下图，选择 RAID级别，并采用
Manual手动方式选择创建卷组的磁盘，点击 Next创建卷组； 

 

图6-3 配置RAID卷：选择物理磁盘 
 

4. 选择配置新卷的容量与名称，如果其他参数使用缺省配置，则点击 Finish完成新卷
的配置工作，如果需要手工配置参数，选择 Custom Setting单选按钮，点击 Next； 
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图6-4 配置RAID卷：选择RAID级别和容量 
 

5. 配置 Volume高级参数，点击 Finish完成新卷的配置； 

 

图6-5 配置RAID卷：选择卷的类型和参数 
 

6. 系统询问是否还要创建其他的卷，可选择 No； 
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图6-6 配置RAID卷：是否继续 

 
7. 点击“OK”，完成新卷的创建。 

 
图6-6 配置RAID卷：完成 

 
8. 点击卷的属性“Property”可以查看逻辑卷的初始化进程，我们强烈建议您进行RAID 
初始化，以使您的系统具有良好的性能和可靠性。 

6.2 设置卷的映射 

为使操作系统识别存储阵列上所创建的卷，需要指定逻辑卷与 LUN号之间映射关系。 
在 Array Management 窗口中选择 Mapping View 页，按下面的步骤就可配置逻辑卷到 LUN
的映射关系。 
如果您没有购买 SANshare Partition 的功能许可证 License，不需要进行此步操作，和

SureFibre220磁盘阵列直接连接或处于同一 SAN Zone中的服务器都可以访问到磁盘阵列上
配置的所有卷！ 
如果您已经购买了 SANshare Partition功能选件，请选择“Storage Array”→“Premium 

Features”→“List”，拷贝所显示的 32位 FeatureID 编号，连同主机后部贴示的 SN，一同发
给联想集团有限公司，申请 License； 

 
△!  说明： 

Feature ID是系统初次启动时（安装的光纤硬盘应无任何相关配置信息）根据控制
器硬件 ID计算出来的，后面 8位则和时间有相关，如果系统中的任何一块磁盘以前有
任何配置信息，ID（甚至包括 NVRAM和 IP）均以硬盘的为主，即硬盘信息的导入优
先级最高。 

您收到的 License 许可是一个注册表项文件，您可以通过选择“Storage Array”→
“Premium Features”→“Enable”，选择您取得的 License文件，点击 OK，即实现了 License
的加载，此时系统就拥有了 SANshare Partition功能，同时阵列管理软件最左下角的 License



联想 SureFibre220磁盘阵列用户手册 

39 

图表原先的红杠消失，您也可以通过选择“Storage Array”→“Premium Features”→“List” 
来查看 License信息，如下图所示： 

 

图 6-7 查看磁盘阵列 Feature ID和 License信息 

 
如果此时 SANshare Partition加载成功，即可以进行逻辑卷的映射配置，请参照下面的

详细步骤指南： 
1. 定义主机组：点击菜单项 Mapping->Host Group进入，主机组名称可以任意命名，建
议以用途（如集群等）或异构平台时以操作系统来命名。 

 
图 6-8 设置卷映射：定义主机组 

2. 定义主机 
在窗口左边的 Topology 栏中选中主机组，点击菜单项 Mapping->Host 进入，主机名
称也同样可以任意命名，一般建议以服务器名字来命名。 

 
图 6-9 设置卷映射：定义主机 
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3. 定义主机端口 
在窗口左边的 Topology栏中选中主机，点击菜单项 Mapping->Host Port进入，
在下拉列表中选择与主机关联的端口标识，选择主机类型，并给定端口名称； 
△!  注意：其中主机端口以 WWN号来表示，请务必记住每一块 HBA的 WWN，一般
对 Windows 和 Linux系统可以在系统启动自检时通过进入 HBA 的 BIOS 查看，而
Solaris 可以通过 dmesg |more命令反查系统启动信息来获取 HBA的 WWN，当然您
也可以通过安装 HBA对应的管理软件来查看，Qlogic HBA对应 SANsufer：Emulex 
HBA对应 HBAnywhere管理软件；主机的名称建议以 HBA的型号类型来命名！ 

 

图 6-10 设置卷映射：定义主机端口 
4. 定义映射关系 
映射关系的定义可以有两种方式： 

² 通过 SANshare Storage Partitioning指定逻辑卷分区； 

² 通过 Additional Mapping指定单独逻辑卷的映射； 

第一种方式是通过 SANshare Storage Partitioning Wizard完成，点击菜单项 Mapping
→SANshare Storage Partitioning进入，如下图，按照 Wizard指引完成映射任务： 

 
图6-11 设置卷映射：选择向导方式 
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1. 选择映射的主机组或主机 
SANtricity 中的映射关系为卷到 Host，其实就是 LUN－HBA，只不过您可以将安
装有 RDAC 虚拟驱动的两块 HBA放在一个 Host里面，然后做一次映射即可。 

 
图6-12 设置卷映射：定义主机组和主机 

 
2. 指定映射的卷及 LUN编号 

 
图6-13 设置卷映射：指定LUN映射 

△!  说明： 
每一个Host必须有一个LUN0，否则系统对卷的识别可能有问题，比如Linux
系统就必须从LUN0开始才能查找到所连接的逻辑卷。 
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3. 完成映射 
如果要单独指定某个卷的映射关系，可以选择第二种方式，点击菜单项 Mapping→

Additional Mapping进入，如下图。 

 
图6-14 设置卷映射：其它方式 

 
在创建完所有的逻辑卷并且设定好逻辑卷到主机之间的映射以后，用户必须在主机的操

作系统中运行新加逻辑卷的识别工具，使操作系统能够识别到新划分的逻辑卷。新增加的逻

辑卷的识别与操作系统相关，有的操作系统不支持在线识别新添加的逻辑卷。详细情况请查

阅相关的操作系统用户手册。 

6.3 保存和加载配置信息 
为保存磁盘阵列相关的配置信息，供以后系统维护和售后支持查阅之用，请务必将当前

阵列的配置信息保存在文件中并进行备份，以便在适当的时候重建原有配置。 

6.3.1 保存配置信息 

在 Array Management窗口中点击菜单项 Storage Array->Configuration->Save，进行如下
操作： 

1. 在警告信息对话框重点击“Yes”； 
2. 在 Save Configuration对话框中，输入要保存配置信息的文件名； 
3. 点击“Save”保存配置文件。 

 
在 Array Management窗口中点击菜单项 View->Storage Array Profile，选择 All标签，
选择 Save As…按钮，将阵列信息保存在某磁盘目录，并取文件名。 
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6.3.2 加载配置信息 

在 Enterprise Management窗口中点击菜单项 Tools->Load Configuration，进行如下操作： 
1. 在警告信息对话框重点击“Yes”； 
2. 在 Load Script对话框中，选择保存配置信息的文件名； 
3. 点击“打开”执行配置文件。 

注意：执行配置文件会清除存储阵列上的数据，并丢失所有映射关系，只保留各卷组和 
卷的配置信息 

说明：SANtricity Storage Manager除了 SANshare Storage Partition外还提供下列附加功能，
需要用户购买相应的 License才能使用，具体功能描述本手册不作赘述，请直接咨
询联想相关技术人员： 
² Snapshot：实时在线逻辑静态拷贝，指针型拷贝，需 Firmware5.40才支持； 

² Volume Copy：实时在线物理拷贝，需 Firmware5.40才支持； 

² Remote Volume Mirroring：基于硬件的远程同步冗灾，需 Firmware6.10才支持； 

6.4 监控磁盘阵列 

本章节简单介绍如何查看和诊断物理设备与逻辑设备状态，如何监控 SANtricity Storage 
Manager 管理软件中的事件日志信息。 

6.4.1Recovery Guru 

磁盘阵列处于“Need Attention”状态时，可以使用 Recovery Guru来查看导致该状态的
原因以及建议采取的措施。 
在 Array Management窗口重点击菜单项 Storage Array->Recovery Guru进入，如下图。 

 
图 6-15 运行 Recovery Guru进行阵列故障诊断 
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6.4.2 控制器故障诊断 

在 Array Management 窗口中选中所要诊断的控制器，点击菜单项 Controller->Run 
Diagnostics进入，点击“Run”进行测试诊断。 

 
图 6-16 运行 Run Diagnostics进行控制器故障诊断 

6.4.3 环路故障诊断 

在Array Management窗口中点击菜单项 Storage Array->Run Read Link Status Diagnostics, 
点击“Run”重新读取状态信息。状态数据可保存在文件中以备查询。 

 
图 6-17运行 Link Status Diagnostics进行环路器故障诊断 
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6.4.4 日志事件监控 

SANtric ity监控所有连接的控制器和其他相关物理设备的运行状况。当一个可识别的行
为发生时，它的结果就是一个事件，如创建一个主机、物理磁盘的损坏等。事件可用来及时

通知管理员某些重要行为与故障的发生，还可以用来进行故障诊断。 
在 Array Management窗口中点击菜单项 View->Event Log进入事件日志查看窗口。事件
日志可保存在文件中以备查询。 

 
图 6-18运行 Event Log进行事件日志监控 

 

提醒： 
完成存储子系统配置之后，根据实际应用，在 OS 下对映射过来的卷进行格式化并加载

文件系统或直接 Mount，运行相关的磁盘压力测试软件或进行大文件拷贝测试，确认存储子

系统工作正常（如在 Windows 下运行 DISK32 程序 12 小时，确认无任何错误显示和系统无

严重警告或错误日志，打开管理软件系统各组件正常，无异常的严重警告或错误日志）；然

后重新启动系统正常后再在磁盘阵列相应卷上安装数据库等应用系统或拷贝多媒体、图书等

文件系统再或者继续安装配置集群等服务； 


